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Q.1 Find the mean proportional between 39 and 54.
Ans A. 3√26

B. 9√26

C. 6√26

D. √26

Question Type : MCQ
Question ID : 4410091430982
Option 1 ID : 4410095652241
Option 2 ID : 4410095652243
Option 3 ID : 4410095652242
Option 4 ID : 4410095652240

Status : Answered
Chosen Option : B

Q.2

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009124690
Option 1 ID : 441009495640
Option 2 ID : 441009495639
Option 3 ID : 441009495642
Option 4 ID : 441009495641

Status : Answered
Chosen Option : B

Q.3 Three numbers are in the ratio 2 : 3 : 5. If the sum of the first and third numbers is 156
more than the second number, find the difference between the first and third numbers.

Ans A. 137

B. 127

C. 117

D. 114

Question Type : MCQ
Question ID : 4410097295
Option 1 ID : 44100928923
Option 2 ID : 44100928921
Option 3 ID : 44100928920
Option 4 ID : 44100928922

Status : Answered
Chosen Option : C
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Q.4 Pipe A can fill a tank in 15 hours, pipe B can fill the same tank in 23 hours, and pipe C
can fill the same tank in 8 hours. The time taken by them (in hours) to fill the same tank,
if they operate together, is:

Ans A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009278023
Option 1 ID : 4410091080053
Option 2 ID : 4410091080051
Option 3 ID : 4410091080054
Option 4 ID : 4410091080052

Status : Answered
Chosen Option : B

Q.5 Find the median of 12, 15, 18, 20, 25, 30, 16, 24.
Ans A. 16

B. 19

C. 18

D. 22

Question Type : MCQ
Question ID : 4410091836869
Option 1 ID : 4410097241106
Option 2 ID : 4410097241108
Option 3 ID : 4410097241107
Option 4 ID : 4410097241109

Status : Answered
Chosen Option : B

Q.6 A shop sells towels under an offer where a customer buys 3 towels and gets 2 towels
free, all having the same marked price. What is the effective discount percentage the
customer receives?

Ans A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009919893
Option 1 ID : 4410093633544
Option 2 ID : 4410093633543
Option 3 ID : 4410093633546
Option 4 ID : 4410093633545

Status : Answered
Chosen Option : B
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Q.7 A principal of ₹10,000 becomes ₹13,000 in 3 years at simple interest. If the annual rate
of interest is increased by 5 percentage points, what will be the amount at the end of 3
years?

Ans A. ₹24,500

B. ₹17,500

C. ₹14,500

D. ₹4,500

Question Type : MCQ
Question ID : 441009916716
Option 1 ID : 4410093621117
Option 2 ID : 4410093621115
Option 3 ID : 4410093621116
Option 4 ID : 4410093621118

Status : Answered
Chosen Option : C

Q.8 If at the same rate of interest, on the same principal, in 2 years, the simple interest is
₹66 and compound interest (compounded annually) is ₹75, then what is the principal (in
₹)?

Ans A. 125

B. 116

C. 114

D. 121

Question Type : MCQ
Question ID : 441009572225
Option 1 ID : 4410092244023
Option 2 ID : 4410092244021
Option 3 ID : 4410092244022
Option 4 ID : 4410092244020

Status : Not Answered
Chosen Option : --

Q.9 The price of an item is first increased by 25%, then decreased by 20%, and finally
increased by 10%. What is the net percentage change in the price?

Ans A. 15% decrease

B. 10% decrease

C. 15% increase

D. 10% increase

Question Type : MCQ
Question ID : 4410091622533
Option 1 ID : 4410096408911
Option 2 ID : 4410096408910
Option 3 ID : 4410096408908
Option 4 ID : 4410096408909

Status : Answered
Chosen Option : B
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Q.10 A can complete a work in 30 days and B in 50 days. If they work on it together for 8
days, then what fraction of the work is left?7066

Ans A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009900379
Option 1 ID : 4410093555589
Option 2 ID : 4410093555588
Option 3 ID : 4410093555587
Option 4 ID : 4410093555586

Status : Answered
Chosen Option : A

Q.11

Ans A. 8.18

B. 3.59

C. 11.68

D. 8.39

Question Type : MCQ
Question ID : 441009575802
Option 1 ID : 4410092258331
Option 2 ID : 4410092258330
Option 3 ID : 4410092258328
Option 4 ID : 4410092258329

Status : Answered
Chosen Option : C

Q.12 A train overtakes two cyclists cycling in the same direction. The first cyclist is cycling
at a speed of 9 km/hr and the second is cycling at 18 km/hr. The train passes them
completely in 10 seconds and 12 seconds, respectively. What is the length of the train?

Ans A. 120 meters

B. 180 meters

C. 190 meters

D. 150 meters

Question Type : MCQ
Question ID : 4410091453171
Option 1 ID : 4410095740980
Option 2 ID : 4410095740982
Option 3 ID : 4410095740983
Option 4 ID : 4410095740981

Status : Not Answered
Chosen Option : --
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Q.13 If in the given figure AB ∥  CD and BE ∥  DF, then find the value of x + y.

Ans A. 208°

B. 188°

C. 204°

D. 200°

Question Type : MCQ
Question ID : 441009622385
Option 1 ID : 4410092443675
Option 2 ID : 4410092443672
Option 3 ID : 4410092443674
Option 4 ID : 4410092443673

Status : Answered
Chosen Option : A

Q.14 96% of the population of a village is 22920. The total population of the village is:
Ans A. 32131

B. 25515

C. 24811

D. 23875

Question Type : MCQ
Question ID : 441009857541
Option 1 ID : 4410093383139
Option 2 ID : 4410093383138
Option 3 ID : 4410093383137
Option 4 ID : 4410093383136

Status : Answered
Chosen Option : D
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Q.15 A dealer sells goods at a loss of 20% on the cost price, but delivers 42% less weight to
the customer. Find his overall percentage profit or loss.

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ
Question ID : 441009272641
Option 1 ID : 4410091059113
Option 2 ID : 4410091059111
Option 3 ID : 4410091059114
Option 4 ID : 4410091059112

Status : Answered
Chosen Option : B

Q.16 The product of two consecutive positive integers is 1640. If the smaller of these
integers is represented by x, which of the following options represents the equation
used to find the value of x?

Ans A. x2 - x + 1640 = 0

B. x2 + x - 1640 = 0

C. x2 - x - 1640 = 0

D. x2 + x + 1640 = 0

Question Type : MCQ
Question ID : 4410091220355
Option 1 ID : 4410094814846
Option 2 ID : 4410094814843
Option 3 ID : 4410094814845
Option 4 ID : 4410094814844

Status : Answered
Chosen Option : D

 

Q.17

Ans A. 182.68 cm2

B. 159.62 cm2

C. 165.35 cm2

D. 173.25 cm2

Question Type : MCQ
Question ID : 441009592193
Option 1 ID : 4410092323892
Option 2 ID : 4410092323889
Option 3 ID : 4410092323890
Option 4 ID : 4410092323891

Status : Not Answered
Chosen Option : --
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Q.18 Three friends, P, Q, and R, invest ₹50,000, ₹75,000, and ₹1,00,000, respectively, in a
business. The total profit is ₹90,000. What is the difference between the profits of P and
R?4334

Ans A. ₹20,000

B. ₹21,500

C. ₹18,000

D. ₹15,000

Question Type : MCQ
Question ID : 441009897647
Option 1 ID : 4410093544660
Option 2 ID : 4410093544661
Option 3 ID : 4410093544659
Option 4 ID : 4410093544658

Status : Answered
Chosen Option : A

Q.19 Devadat drives the first 120 km at 60 km/hr and the next 120 km at 40 km/hr. Find the
average speed (in km/hr) for the entire duration.

Ans A. 46

B. 48

C. 44

D. 42

Question Type : MCQ
Question ID : 441009290956
Option 1 ID : 4410091130697
Option 2 ID : 4410091130698
Option 3 ID : 4410091130696
Option 4 ID : 4410091130695

Status : Answered
Chosen Option : B

Q.20 The average of 10 numbers is 15. The average of 8 of these numbers is 12. The average
of the remaining two numbers is:

Ans A. 27

B. 28

C. 29

D. 26

Question Type : MCQ
Question ID : 441009272595
Option 1 ID : 4410091058927
Option 2 ID : 4410091058928
Option 3 ID : 4410091058930
Option 4 ID : 4410091058929

Status : Answered
Chosen Option : A

Section : General Studies
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Q.21 Which of the following conditions will make the current in a circuit zero even though a
potential difference exists?

Ans A. The resistance is zero

B. The circuit is open

C. The resistance is low

D. The circuit is closed

Question Type : MCQ
Question ID : 4410091433504
Option 1 ID : 4410095662564
Option 2 ID : 4410095662565
Option 3 ID : 4410095662566
Option 4 ID : 4410095662567

Status : Answered
Chosen Option : D

Q.22 What action by the British prompted Lala Lajpat Rai’s protest that led to his death?
Ans A. Execution of Bhagat Singh

B. Protest against the Simon Commission

C. Arrest of Tilak and Gandhi

D. Implementation of the Rowlatt Act

Question Type : MCQ
Question ID : 4410091068421
Option 1 ID : 4410094219186
Option 2 ID : 4410094219185
Option 3 ID : 4410094219183
Option 4 ID : 4410094219184

Status : Answered
Chosen Option : B

Q.23 Which political party is ruling Karnataka as of September 2025, and who is its Chief
Minister?

Ans A. Aam Aadmi Party — Arvind Kejriwal

B. Indian National Congress — Siddaramaiah

C. Bharatiya Janata Party — Basavaraj Bommai

D. Janata Dal (Secular) — HD Kumaraswamy

Question Type : MCQ
Question ID : 4410091309260
Option 1 ID : 4410095168673
Option 2 ID : 4410095168671
Option 3 ID : 4410095168670
Option 4 ID : 4410095168672

Status : Answered
Chosen Option : B
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Q.24 The decline in the proportion of child population (0–6 years) between 2001 and 2011
mainly indicates which demographic trend in India?

Ans A. Declining fertility

B. Increasing migration

C. Increasing infant mortality

D. Increasing fertility

Question Type : MCQ
Question ID : 441009866529
Option 1 ID : 4410093419149
Option 2 ID : 4410093419151
Option 3 ID : 4410093419150
Option 4 ID : 4410093419148

Status : Not Answered
Chosen Option : --

Q.25 Which distinctive characteristic sets the Mahanadi River system apart from other major
rivers flowing through Odisha?

Ans A. Known for the Hirakud Dam and falls in to the Bay of Bengal

B. Flowing directly into the Arabian Sea

C. Being the shortest river in Odisha

D. Originating from the Chhotnagpur plateau of Jharkhand

Question Type : MCQ
Question ID : 4410091848687
Option 1 ID : 4410097286981
Option 2 ID : 4410097286983
Option 3 ID : 4410097286984
Option 4 ID : 4410097286982

Status : Answered
Chosen Option : A

Q.26 What is the percentage of carbon in earth’s crust?
Ans A. 0.02%

B. 0.1%

C. 0.2%

D. 0.01%

Question Type : MCQ
Question ID : 4410091435139
Option 1 ID : 4410095669091
Option 2 ID : 4410095669088
Option 3 ID : 4410095669090
Option 4 ID : 4410095669089

Status : Answered
Chosen Option : C
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Q.27 Who was the first head of the government (Prime Minister/Chief Minister) of Odisha
after it became a separate province in 1936?

Ans A. Krushna Chandra Gajapati

B. Biju Patnaik

C. Harekrushna Mahatab

D. Nabakrushna Choudhuri

Question Type : MCQ
Question ID : 4410091334445
Option 1 ID : 4410095269449
Option 2 ID : 4410095269447
Option 3 ID : 4410095269450
Option 4 ID : 4410095269448

Status : Answered
Chosen Option : C

Q.28 How do weeds affect crop production?
Ans A. They increase crop yield by doing more photosynthesis.

B. They decrease soil fertility by organic matter addition evenly.

C. They protect crops from pests and diseases.

D. They compete with crops for nutrients, water, and light.

Question Type : MCQ
Question ID : 4410091443556
Option 1 ID : 4410095702758
Option 2 ID : 4410095702760
Option 3 ID : 4410095702761
Option 4 ID : 4410095702759

Status : Answered
Chosen Option : C

Q.29 Which of the following initiatives was launched by the Odisha government in June 2025
to enhance public awareness and participation in governance, deploying mobile
vehicles across blocks and municipalities?

Ans A. Jan Bhagidari Yatra

B. Vikas Vahan Yatra

C. Viksit Odisha 2036

D. Smart Odisha Drive

Question Type : MCQ
Question ID : 4410091472621
Option 1 ID : 4410095818352
Option 2 ID : 4410095818350
Option 3 ID : 4410095818349
Option 4 ID : 4410095818351

Status : Answered
Chosen Option : B
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Q.30 Which of the following ports is located on the western coastal plain of India?
Ans A. Chennai

B. Paradeep

C. Vishakhapatnam

D. Marmagao

Question Type : MCQ
Question ID : 441009999577
Option 1 ID : 4410093950149
Option 2 ID : 4410093950150
Option 3 ID : 4410093950152
Option 4 ID : 4410093950151

Status : Answered
Chosen Option : D

Q.31 The Election Commission of India was established as a permanent and independent
Constitutional body to ensure what in the country?

Ans A. Judicial independence

B. Economic reforms

C. Free and fair elections

D. Social justice

Question Type : MCQ
Question ID : 4410091213482
Option 1 ID : 4410094787335
Option 2 ID : 4410094787332
Option 3 ID : 4410094787334
Option 4 ID : 4410094787333

Status : Answered
Chosen Option : A

Q.32 When comparing the average thickness of the Earth's crust under different regions,
which statement accurately reflects the variation?

Ans A. The crust is thinnest under continents and thickest under oceans

B. The crust has the same thickness everywhere

C. The crust is thickest under ocean floors and thinnest beneath mountains

D. The crust is thickest beneath mountains and thinnest beneath oceans

Question Type : MCQ
Question ID : 4410091841233
Option 1 ID : 4410097258110
Option 2 ID : 4410097258111
Option 3 ID : 4410097258112
Option 4 ID : 4410097258109

Status : Not Answered
Chosen Option : --
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Q.33 As per the Human Development Index (HDI) value of 2022 released by UNDP, India is
under which human development category?

Ans A. Low human development

B. Very high human development

C. Medium human development

D. High human development

Question Type : MCQ
Question ID : 441009510821
Option 1 ID : 4410091998443
Option 2 ID : 4410091998442
Option 3 ID : 4410091998444
Option 4 ID : 4410091998445

Status : Answered
Chosen Option : C

Q.34 What did the Indian government do to honor Mangal Pandey, an important figure in the
Revolt of 1857?

Ans A. Issued a commemorative stamp in 1984

B. Named a city after him

C. Built a monument in London

D. Gave him a national award posthumously

Question Type : MCQ
Question ID : 441009862367
Option 1 ID : 4410093402591
Option 2 ID : 4410093402590
Option 3 ID : 4410093402592
Option 4 ID : 4410093402593

Status : Not Answered
Chosen Option : --

Q.35 According to The Citizenship Act, 1955, who is considered an illegal migrant?
Ans A. A foreigner who visits India for tourism

B. A foreigner entering without valid documents or overstaying

C. An Indian citizen who renounces their nationality

D. A foreign diplomat staying in India

Question Type : MCQ
Question ID : 4410091283161
Option 1 ID : 4410095064318
Option 2 ID : 4410095064321
Option 3 ID : 4410095064320
Option 4 ID : 4410095064319

Status : Answered
Chosen Option : C
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Q.36 In February 2024, India announced the establishment of the International Big Cat
Alliance (IBCA) with its headquarter in New Delhi. How many of the seven big cats are
found in India, and which are they?

Ans A. Four – Tiger, Lion, Leopard, Snow Leopard

B. Five – Tiger, Lion, Puma, Jaguar, Cheetah

C. Six – Tiger, Lion, Leopard, Snow Leopard, Puma, Cheetah

D. Five – Tiger, Lion, Leopard, Snow Leopard, Cheetah

Question Type : MCQ
Question ID : 4410091204228
Option 1 ID : 4410094750412
Option 2 ID : 4410094750413
Option 3 ID : 4410094750414
Option 4 ID : 4410094750411

Status : Answered
Chosen Option : D

Q.37 At the 12th Beijing Xiangshan Forum, China emphasised a strategic stance challenging
which of the following?

Ans A. Global health-governance frameworks

B. Digital privacy treaties

C. US-led international order and hegemonism

D. Regional free-trade zones

Question Type : MCQ
Question ID : 4410091469576
Option 1 ID : 4410095806268
Option 2 ID : 4410095806269
Option 3 ID : 4410095806266
Option 4 ID : 4410095806267

Status : Not Answered
Chosen Option : --

Q.38 From 30 September to 2 November 2025, in which country will the ICC Women’s Cricket
World Cup be held?

Ans A. Pakistan and Sri Lanka

B. England and India

C. Afghanistan and Bangladesh

D. India and Sri Lanka

Question Type : MCQ
Question ID : 4410091261100
Option 1 ID : 4410094977287
Option 2 ID : 4410094977285
Option 3 ID : 4410094977288
Option 4 ID : 4410094977286

Status : Answered
Chosen Option : D
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Q.39 Which railway line in Odisha connects Cuttack to Sambalpur and traverses the central
region, facilitating freight movement of coal and minerals?

Ans A. Cuttack–Sambalpur line

B. Talcher–Sambalpur line

C. Haridaspur–Paradeep line

D. Howrah–Chennai main line

Question Type : MCQ
Question ID : 4410091338609
Option 1 ID : 4410095286525
Option 2 ID : 4410095286526
Option 3 ID : 4410095286527
Option 4 ID : 4410095286524

Status : Not Answered
Chosen Option : --

Q.40 The 64th edition of the Sahani Cup, held in Odisha in July 2025, is associated with
which of the following sports?

Ans A. Kabaddi

B. Football

C. Hockey

D. Volleyball

Question Type : MCQ
Question ID : 4410091526144
Option 1 ID : 4410096027709
Option 2 ID : 4410096027707
Option 3 ID : 4410096027706
Option 4 ID : 4410096027708

Status : Answered
Chosen Option : B

Q.41 Who authored the famous Indian storybook 'Panchatantra'?
Ans A. Kalidasa

B. Vatsyayana

C. Vishnu Sharma

D. Valmiki

Question Type : MCQ
Question ID : 441009185401
Option 1 ID : 441009732924
Option 2 ID : 441009732926
Option 3 ID : 441009732925
Option 4 ID : 441009732927

Status : Answered
Chosen Option : C
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Q.42 Which Article of the Indian Constitution directs the State to provide early childhood
care and education up to six years of age?

Ans A. Article 44

B. Article 46

C. Article 45

D. Article 43

Question Type : MCQ
Question ID : 4410091443456
Option 1 ID : 4410095702339
Option 2 ID : 4410095702341
Option 3 ID : 4410095702340
Option 4 ID : 4410095702338

Status : Not Answered
Chosen Option : --

Q.43 Who among the following is considered a pioneer social reformer and writer of modern
Odisha’s renaissance?

Ans A. Raja Ram Mohan Roy

B. Madhusudan Das

C. Fakir Mohan Senapati

D. Subhas Chandra Bose

Question Type : MCQ
Question ID : 441009642200
Option 1 ID : 4410092522943
Option 2 ID : 4410092522945
Option 3 ID : 4410092522946
Option 4 ID : 4410092522944

Status : Not Answered
Chosen Option : --

Q.44 Which Indian athlete set a new national record in the men’s marathon race walk in 2026
with a timing of 3:09:17?

Ans A. Avinash Sable

B. Neeraj Chopra

C. Murali Sreeshankar

D. Ram Baboo

Question Type : MCQ
Question ID : 4410091834290
Option 1 ID : 4410097231042
Option 2 ID : 4410097231040
Option 3 ID : 4410097231043
Option 4 ID : 4410097231041

Status : Answered
Chosen Option : A
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Q.45 Which tournament represents India’s premier domestic cricket competition?
Ans A. Ranji Trophy

B. Durand Cup

C. Nehru Trophy

D. Dhyan Chand Trophy

Question Type : MCQ
Question ID : 4410091848003
Option 1 ID : 4410097284296
Option 2 ID : 4410097284297
Option 3 ID : 4410097284299
Option 4 ID : 4410097284298

Status : Answered
Chosen Option : A

Q.46 Identify the part of the sentence that contains the error and choose the correct
sentence.

Either we submit the report today, or but we will face penalties from the management.
Ans A. Either we submit the report today, or we will face penalties from the management.

B. Either we submit the report today, and we will face penalties from the management.

C. Either we submit the report today, or yet we will face penalties from the management.

D. We submit the report today, but we will face penalties from the management.

Question Type : MCQ
Question ID : 4410091825495
Option 1 ID : 4410097196285
Option 2 ID : 4410097196284
Option 3 ID : 4410097196283
Option 4 ID : 4410097196286

Status : Answered
Chosen Option : A

Q.47 Which sentence demonstrates correct use of the past perfect tense?
Ans A. They had completed their project before the manager checked.

B. They complete their project every month.

C. They will complete their project next week.

D. They have completed their project on time.

Question Type : MCQ
Question ID : 4410091827946
Option 1 ID : 4410097205985
Option 2 ID : 4410097205984
Option 3 ID : 4410097205986
Option 4 ID : 4410097205983

Status : Answered
Chosen Option : A

Section : English
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Q.48 Complete the given sentence by choosing the correct form of present tense.

Every morning, the marketing team _______ the daily report and sends it to the
management before 10 a.m.

Ans A. has prepared

B. prepares

C. is preparing

D. prepare

Question Type : MCQ
Question ID : 4410091828593
Option 1 ID : 4410097208541
Option 2 ID : 4410097208539
Option 3 ID : 4410097208540
Option 4 ID : 4410097208538

Status : Answered
Chosen Option : D

Q.49 Choose the correct meaning of the proverb/phrase from the given alternatives.

After rain comes fair weather
Ans A. To ruin someone’s predetermined plans and pleasures

B. To form unrealistic opinions about a certain situation

C. A brief moment of peace before the difficult period arrives

D. Hardships and difficult times are bound to be followed by good times

Question Type : MCQ
Question ID : 44100948361
Option 1 ID : 441009192644
Option 2 ID : 441009192647
Option 3 ID : 441009192646
Option 4 ID : 441009192645

Status : Answered
Chosen Option : D

Q.50 Parts of a sentence are given below in jumbled order. Arrange the parts in the correct
order to form a meaningful sentence.

P: men to work together and
Q: corporate discipline
R: therefore encourage
S: sports and games teach

Ans A. SQPR

B. RSQP

C. QRSP

D. SPRQ

Question Type : MCQ
Question ID : 44100930973
Option 1 ID : 441009123380
Option 2 ID : 441009123381
Option 3 ID : 441009123382
Option 4 ID : 441009123383

Status : Answered
Chosen Option : D
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Q.51 Select the most appropriate one-word substitute for the highlighted words.

She decided to specialise in the study of viruses during her postgraduate research.
Ans A. microbiology

B. pathology

C. virology

D. bacteriology

Question Type : MCQ
Question ID : 4410091818141
Option 1 ID : 4410097167947
Option 2 ID : 4410097167948
Option 3 ID : 4410097167946
Option 4 ID : 4410097167949

Status : Answered
Chosen Option : B

Q.52 Which is the correct indirect speech form of the given sentence?

Riya said, “I will finish the assignment tomorrow.”
Ans A. Riya said that she would finish the assignment tomorrow.

B. Riya said that she would finish the assignment the next day.

C. Riya said that she will finish the assignment tomorrow.

D. Riya said that she finishes the assignment the next day.

Question Type : MCQ
Question ID : 4410091828526
Option 1 ID : 4410097208272
Option 2 ID : 4410097208271
Option 3 ID : 4410097208270
Option 4 ID : 4410097208273

Status : Answered
Chosen Option : B

Q.53 Select the most appropriate option to substitute the underlined word segment in the
given sentence.

He declared during the ceremony that he is a/an person who does not believe in God.
Ans A. Theist

B. Agnostic

C. Deist

D. Atheist

Question Type : MCQ
Question ID : 4410091817497
Option 1 ID : 4410097165403
Option 2 ID : 4410097165404
Option 3 ID : 4410097165405
Option 4 ID : 4410097165402

Status : Answered
Chosen Option : B
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Q.54 Choose the option that is an antonym of the underlined word in the sentence below.

The explorer's dauntless spirit allowed him to face the perilous ascent of the mountain
without hesitation.

Ans A. bold

B. fearless

C. courageous

D. timid

Question Type : MCQ
Question ID : 4410091456916
Option 1 ID : 4410095755967
Option 2 ID : 4410095755969
Option 3 ID : 4410095755966
Option 4 ID : 4410095755968

Status : Answered
Chosen Option : D

Q.55 Choose the sentence with the correct active voice usage.
Ans A. The students repeatedly interrupted the presentation.

B. The presentation was repeatedly interrupted by the students.

C. The students was repeatedly interrupting the presentation.

D. The students had repeatedly interrupted by the presentation.

Question Type : MCQ
Question ID : 4410091834732
Option 1 ID : 4410097232774
Option 2 ID : 4410097232775
Option 3 ID : 4410097232772
Option 4 ID : 4410097232773

Status : Answered
Chosen Option : C

Q.56 Choose the sentence with an incorrect adverb.
Ans A. He speaks English fluent during meetings.

B. The student answered all the questions correctly.

C. They responded immediately to the request.

D. She handled the situation tactfully.

Question Type : MCQ
Question ID : 4410091793826
Option 1 ID : 4410097073103
Option 2 ID : 4410097073105
Option 3 ID : 4410097073104
Option 4 ID : 4410097073102

Status : Answered
Chosen Option : C
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Q.57 What is the closest meaning of the given proverb?
A journey of a thousand miles begins with a single step.

Ans A. Long journeys are always difficult to complete.

B. One must plan thoroughly before starting any journey.

C. Any great achievement begins with a small, initial action.

D. Success is guaranteed if the journey is long and meaningful.

Question Type : MCQ
Question ID : 4410091167119
Option 1 ID : 4410094603125
Option 2 ID : 4410094603127
Option 3 ID : 4410094603126
Option 4 ID : 4410094603128

Status : Answered
Chosen Option : C

Q.58 Identify the error in the given sentence.

The board, together with / all its senior advisors, / have unanimously approved the /
restructured institutional assessment framework.

Ans A. have unanimously approved the

B. all its senior advisors,

C. The board, together with

D. restructured institutional assessment framework.

Question Type : MCQ
Question ID : 4410091848458
Option 1 ID : 4410097286095
Option 2 ID : 4410097286094
Option 3 ID : 4410097286093
Option 4 ID : 4410097286096

Status : Answered
Chosen Option : A

Q.59 Which option is the closest in meaning to the underlined word in the sentence?

The lawyer provided explicit reasons for rejecting the proposal.
Ans A. elegant

B. sensitive

C. optimistic

D. precise

Question Type : MCQ
Question ID : 4410091832839
Option 1 ID : 4410097225353
Option 2 ID : 4410097225356
Option 3 ID : 4410097225355
Option 4 ID : 4410097225354

Status : Answered
Chosen Option : A
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Q.60 Select the option that can be used as a one-word substitute for the highlighted phrase
in the given sentence.

Despite being insulted repeatedly, he remained calm and did not show any resentment,
displaying a strong willingness to forgive and not be angry.

Ans A. tolerance

B. vengeance

C. hostility

D. magnanimity

Question Type : MCQ
Question ID : 4410091800186
Option 1 ID : 4410097097820
Option 2 ID : 4410097097819
Option 3 ID : 4410097097821
Option 4 ID : 4410097097818

Status : Answered
Chosen Option : A

Comprehension:
Read the passage and choose the correct answer to the questions based on it.

Hornbills are distinctive birds known for their large, curved bills and colorful casque, a hollow
structure on top of their beaks. They are mainly found in tropical and subtropical regions of
Africa and Asia, where they inhabit forests, woodlands, and savannas. Hornbills play an
important ecological role because they help disperse seeds while feeding on fruits, which
contributes to forest regeneration. Many hornbill species also eat insects, small animals, and
other plant materials. One of the most remarkable features of hornbills is their unique nesting
behavior. In several species, the female seals herself inside a tree cavity using mud and food
remains, leaving only a narrow slit through which the male passes food until the chicks are
strong enough to emerge. Unfortunately, habitat destruction and illegal hunting have
threatened many hornbill populations. Conservation programs now focus on protecting forests
and raising awareness about the importance of these birds in maintaining healthy ecosystems.

SubQuestion No : 61
Q.61 Which of the following would be the most appropriate title for the passage?
Ans A. The Evolution of Tropical Bird Wings

B. The Migration Patterns of Torrid Birds

C. Hornbills: Unique Birds of Tropical Forests

D. Insects and Forest Ecosystems

Question Type : MCQ
Question ID : 4410091825376
Option 1 ID : 4410097195814
Option 2 ID : 4410097195812
Option 3 ID : 4410097195811
Option 4 ID : 4410097195813

Status : Not Answered
Chosen Option : --
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Comprehension:
Read the passage and choose the correct answer to the questions based on it.

Hornbills are distinctive birds known for their large, curved bills and colorful casque, a hollow
structure on top of their beaks. They are mainly found in tropical and subtropical regions of
Africa and Asia, where they inhabit forests, woodlands, and savannas. Hornbills play an
important ecological role because they help disperse seeds while feeding on fruits, which
contributes to forest regeneration. Many hornbill species also eat insects, small animals, and
other plant materials. One of the most remarkable features of hornbills is their unique nesting
behavior. In several species, the female seals herself inside a tree cavity using mud and food
remains, leaving only a narrow slit through which the male passes food until the chicks are
strong enough to emerge. Unfortunately, habitat destruction and illegal hunting have
threatened many hornbill populations. Conservation programs now focus on protecting forests
and raising awareness about the importance of these birds in maintaining healthy ecosystems.

SubQuestion No : 62
Q.62 What is the main theme of the passage?
Ans A. The development of wildlife tourism

B. The economic value of forest birds

C. The characteristics of hornbills

D. The history of bird domestication

Question Type : MCQ
Question ID : 4410091825377
Option 1 ID : 4410097195818
Option 2 ID : 4410097195816
Option 3 ID : 4410097195815
Option 4 ID : 4410097195817

Status : Not Answered
Chosen Option : --

Comprehension:
Read the passage and choose the correct answer to the questions based on it.

Hornbills are distinctive birds known for their large, curved bills and colorful casque, a hollow
structure on top of their beaks. They are mainly found in tropical and subtropical regions of
Africa and Asia, where they inhabit forests, woodlands, and savannas. Hornbills play an
important ecological role because they help disperse seeds while feeding on fruits, which
contributes to forest regeneration. Many hornbill species also eat insects, small animals, and
other plant materials. One of the most remarkable features of hornbills is their unique nesting
behavior. In several species, the female seals herself inside a tree cavity using mud and food
remains, leaving only a narrow slit through which the male passes food until the chicks are
strong enough to emerge. Unfortunately, habitat destruction and illegal hunting have
threatened many hornbill populations. Conservation programs now focus on protecting forests
and raising awareness about the importance of these birds in maintaining healthy ecosystems.

SubQuestion No : 63
Q.63 According to the passage, which statement about hornbills is correct?
Ans A. Hornbills regenerate forests by dispersing seeds.

B. Female hornbills leave immediately after laying eggs.

C. Hornbills are mainly found in cold polar regions.

D. Hornbills survive only by eating insects.

Question Type : MCQ
Question ID : 4410091825378
Option 1 ID : 4410097195820
Option 2 ID : 4410097195822
Option 3 ID : 4410097195819
Option 4 ID : 4410097195821

Status : Answered
Chosen Option : C
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Comprehension:
Read the passage and choose the correct answer to the questions based on it.

Hornbills are distinctive birds known for their large, curved bills and colorful casque, a hollow
structure on top of their beaks. They are mainly found in tropical and subtropical regions of
Africa and Asia, where they inhabit forests, woodlands, and savannas. Hornbills play an
important ecological role because they help disperse seeds while feeding on fruits, which
contributes to forest regeneration. Many hornbill species also eat insects, small animals, and
other plant materials. One of the most remarkable features of hornbills is their unique nesting
behavior. In several species, the female seals herself inside a tree cavity using mud and food
remains, leaving only a narrow slit through which the male passes food until the chicks are
strong enough to emerge. Unfortunately, habitat destruction and illegal hunting have
threatened many hornbill populations. Conservation programs now focus on protecting forests
and raising awareness about the importance of these birds in maintaining healthy ecosystems.

SubQuestion No : 64
Q.64 Which inference can be drawn from the passage?
Ans A. Habitat destruction benefits hornbill populations.

B. Protecting forests is essential for survival of hornbills.

C. Hornbills easily adapt to any environment.

D. Hornbills have no ecological importance in forests.

Question Type : MCQ
Question ID : 4410091825379
Option 1 ID : 4410097195826
Option 2 ID : 4410097195823
Option 3 ID : 4410097195825
Option 4 ID : 4410097195824

Status : Not Answered
Chosen Option : --

Comprehension:
Read the passage and choose the correct answer to the questions based on it.

Hornbills are distinctive birds known for their large, curved bills and colorful casque, a hollow
structure on top of their beaks. They are mainly found in tropical and subtropical regions of
Africa and Asia, where they inhabit forests, woodlands, and savannas. Hornbills play an
important ecological role because they help disperse seeds while feeding on fruits, which
contributes to forest regeneration. Many hornbill species also eat insects, small animals, and
other plant materials. One of the most remarkable features of hornbills is their unique nesting
behavior. In several species, the female seals herself inside a tree cavity using mud and food
remains, leaving only a narrow slit through which the male passes food until the chicks are
strong enough to emerge. Unfortunately, habitat destruction and illegal hunting have
threatened many hornbill populations. Conservation programs now focus on protecting forests
and raising awareness about the importance of these birds in maintaining healthy ecosystems.

SubQuestion No : 65
Q.65 Which word is the antonym of “destruction”?
Ans A. Confrontation

B. Restoration

C. Secretion

D. Respiration

Question Type : MCQ
Question ID : 4410091825380
Option 1 ID : 4410097195829
Option 2 ID : 4410097195828
Option 3 ID : 4410097195830
Option 4 ID : 4410097195827

Status : Not Answered
Chosen Option : --
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Q.66 ନିମ୍ନରେ ଦିଆଯାଇଥିବା ବିକଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁକ୍ତ ବିପରୀତ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ
ଅଥୟ

Ans A. ବ୍ୟକ୍ତି

B. ଥୟ

C. ଆତୁର

D. ମଣିଷ

Question Type : MCQ
Question ID : 4410091676106
Option 1 ID : 4410096613246
Option 2 ID : 4410096613245
Option 3 ID : 4410096613244
Option 4 ID : 4410096613247

Status : Answered
Chosen Option : B

Q.67 "ଧୁଆ ମୂଳା ଅଧୂଆ ମୂଳା ସବୁ ସମାନ"-ନିମ୍ନଲିଖିତ ମଧ୍ୟରୁ  କେଉଁ ଟି ଲୋକୋକ୍ତିର ଉପଯୁକ୍ତ ଅର୍ଥ ?
Ans A. ସମସ୍ତଙ୍କୁ ସମାନ ବିଚାର କରିବା

B. ବିଭେଦ ସୃଷ୍ଟି  କରିବା

C. ସର୍ବନାଶ କରିବା

D. ଧୁଆ ମୂଳା ଅଧୂଆ ମୂଳା କିଛି ନ ଥାଏ

Question Type : MCQ
Question ID : 4410091452738
Option 1 ID : 4410095739308
Option 2 ID : 4410095739307
Option 3 ID : 4410095739309
Option 4 ID : 4410095739306

Status : Answered
Chosen Option : A

Q.68 ଦିଆଯାଇଥିବା ଓଡ଼ିଆ ବାକ୍ୟର ସବୁଠାରୁ  ଉପଯୁକ୍ତ ଇଂରାଜୀ ଅନୁବାଦ ବିକଳ୍ପ ବାଛନ୍ତୁ।
ମୋ ସାଙ୍ଗରେ ବଜାର ଯିବାକୁ ଭାଇର କେବେ ସମୟ ନଥାଏ।

Ans A. Brother don't have time forme to go to market.

B. My Brother never have time to go to market with me.

C. My Brother didn’t go to market with me.

D. My Brother does not go to market with me.

Question Type : MCQ
Question ID : 4410091230894
Option 1 ID : 4410094857054
Option 2 ID : 4410094857056
Option 3 ID : 4410094857057
Option 4 ID : 4410094857055

Status : Answered
Chosen Option : B
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Q.69 କିଛି ଶବ୍ଦ ଭୁ ଲ ଲେଖା ହୋଇଥିବା ଏକ ବାକ୍ୟ ଦିଆଯାଇଛି। ବିକଳ୍ପ ଗୁଡିକରୁ  ଗୋଟିଏ ବାଛନ୍ତୁ, ଯେଉଁ ଥିରେ କୌଣସି
ବନାନ ତ୍ରୁଟି ନାହିଁ।

ଉତ୍ତରପ୍ରଦେଶ ର ଅଯୋଧ୍ୟା ରେ ପ୍ରଭୁ  ଶ୍ରୀରାମ ଙ୍କ ଏକ ଭବ୍ୟ ମନ୍ଦିର ନିର୍ମାଣ କରାଯାଇଛି।
Ans A. ଉତ୍ତରପ୍ରଦେଷ ର ଅଜୋଧ୍ୟା ରେ ପ୍ରଭୁ  ଶ୍ରୀରାମ ଙ୍କ ଏକ ଭବ୍ୟ ମନ୍ଦିର ନୀର୍ମାଣ କରାଯାଇଛି।

B. ଉତ୍ତରପ୍ରଦେସ ର ଅଯୋଧ୍ୟା ରେ ପ୍ରଭୁ  ଶ୍ରୀରାମ ଙ୍କ ଏକ ଭବ୍ୟ ମନ୍ଦିର ନିର୍ମାଣ କରାଯାଇଛୀ।

C. ଉତ୍ତରପ୍ରଦେଶ ର ଅଯୋଧ୍ୟା ରେ ପ୍ରଭୁ  ଶ୍ରୀରାମ ଙ୍କ ଏକ ଭବ୍ୟ ମନ୍ଦିର ନିର୍ମାଣ କରାଯାଇଛି।

D. ଉତ୍ତରପ୍ରଦେଶ ର ଅଯୋଧ୍ୟା ରେ ପ୍ରଭୁ  ଶ୍ରିରାମ ଙ୍କ ଏକ ଭବ୍ୟ ମନ୍ଦୀର ନିର୍ମାଣ କରାଯାଇଛି।

Question Type : MCQ
Question ID : 4410091236299
Option 1 ID : 4410094878773
Option 2 ID : 4410094878774
Option 3 ID : 4410094878776
Option 4 ID : 4410094878775

Status : Answered
Chosen Option : C

Q.70 ଆମେ ଦଶ ବର୍ଷ ଧରି ଏହି ସହରରେ ______ ।
Ans A. ରହିଛୁ

B. ବଞ୍ଚିଛୁ

C. ବଞ୍ଚିଲି

D. ରହିବି

Question Type : MCQ
Question ID : 4410091675569
Option 1 ID : 4410096611197
Option 2 ID : 4410096611196
Option 3 ID : 4410096611199
Option 4 ID : 4410096611198

Status : Answered
Chosen Option : A

Q.71 ପାଣି 100°C ତାପମାତ୍ରାରେ ______।
Ans A. ଫୁଟେ

B. ଜଳେ

C. ଫୁଟିବ

D. ଫୁଟିପାରେ

Question Type : MCQ
Question ID : 4410091675610
Option 1 ID : 4410096611303
Option 2 ID : 4410096611300
Option 3 ID : 4410096611301
Option 4 ID : 4410096611302

Status : Answered
Chosen Option : A
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Q.72 “ଏହା ମଧ୍ୟରୁ  କେଉଁ ଟି ତତ୍ସମ ଶବ୍ଦ ଅଟେ?
Ans A. ଯଅ

B. କାନ

C. ଲଟା

D. ସଂସାର

Question Type : MCQ
Question ID : 4410091235906
Option 1 ID : 4410094877205
Option 2 ID : 4410094877202
Option 3 ID : 4410094877204
Option 4 ID : 4410094877203

Status : Answered
Chosen Option : D

Q.73 ଦିଆଯାଇଥିବା ଓଡ଼ିଆ ବାକ୍ୟର ସବୁଠାରୁ  ଉପଯୁକ୍ତ ଇଂରାଜୀ ଅନୁବାଦ ବିକଳ୍ପ ବାଛନ୍ତୁ।

ରାମ ସବୁବେଳେ ଭୋରରୁ  କ୍ରିକେଟ ଖେଳିବାକୁ ଯାଏ।
Ans A. Ram always goes to play cricket.

B. Ram was always going to play cricket early in the morning.

C. Ram goes to play cricket in the morning.

D. Ram always goes to play cricket early in the morning.

Question Type : MCQ
Question ID : 4410091232833
Option 1 ID : 4410094865020
Option 2 ID : 4410094865021
Option 3 ID : 4410094865023
Option 4 ID : 4410094865022

Status : Answered
Chosen Option : D

Q.74 ସେମାନେ ଏବେ ବଗିଚାରେ କାମ ______ ।
Ans A. କରୁ ଛନ୍ତି

B. କରୁ ଥି ଲେ

C. କରିବି

D. କରୁ ଛି

Question Type : MCQ
Question ID : 4410091675647
Option 1 ID : 4410096611416
Option 2 ID : 4410096611417
Option 3 ID : 4410096611419
Option 4 ID : 4410096611418

Status : Answered
Chosen Option : A

https://adda247.go.link/2CeOD
https://adda247.go.link/2CeOD


Q.75 ଦିଆଯାଇଥିବା ଇଂରାଜୀ ବାକ୍ୟକୁ ଓଡ଼ିଆରେ ଅନୁବାଦ କର।

We are going to the sunset point to watch the beautiful sunset.
Ans A. ସନସେଟ୍  ପଏଣ୍ଟରେ ସୂର୍ଯ୍ୟାସ୍ତ ସୁନ୍ଦର ଦେଖାଯାଉଛି।

B. ଆମେ ସୁନ୍ଦର ସୂର୍ଯ୍ୟାସ୍ତ ଦେଖି ବା ପାଇଁ  ସନସେଟ୍  ପଏଣ୍ଟକୁ ଯାଇଥି ଲୁ।

C. ଆମେ ସୁନ୍ଦର ସୂର୍ଯ୍ୟାସ୍ତ ଦେଖି ବା ପାଇଁ  ସନସେଟ୍  ପଏଣ୍ଟକୁ ଯାଉଛୁ।

D. ସୁନ୍ଦର ସୂର୍ଯ୍ୟାସ୍ତ ଦେଖି ବା ପାଇଁ  ସନସେଟ୍  ପଏଣ୍ଟକୁ ଆମେ ଯିବୁ।

Question Type : MCQ
Question ID : 4410091235171
Option 1 ID : 4410094874421
Option 2 ID : 4410094874418
Option 3 ID : 4410094874420
Option 4 ID : 4410094874419

Status : Answered
Chosen Option : C

Comprehension:

ନିମ୍ନ ଲିଖି ତ ଅନୁଚ୍ଛେଦର ବିଷୟବସ୍ତୁକୁ ଭଲଭାବରେ ପଢ଼ନ୍ତୁ। ତା’ତଳେ ପ୍ରଦତ୍ତ ପ୍ରତ୍ୟେକ ପ୍ରଶ୍ନର ଚାରୋଟି ସମ୍ଭାବିତ ଉତ୍ତର
ମଧ୍ୟରୁ  ସଠିକ ଉତ୍ତରକୁ ଚୟନ କରନ୍ତୁ ।

ସବୁ ଅପେକ୍ଷାର ଅନ୍ତ ଘଟିଥି ଲା ଏବଂ ଭାରତୀୟ ମହାକାଶଚାରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଳାଙ୍କ ମହାକାଶ ମିଶନ ଆରମ୍ଭ ହୋଇଥି ଲା।
ସ୍ପେସ୍ ଏକ୍ସର ଆକ୍ସିୟମ ମିଶନ-4ର ସଫଳ ଉତକ୍ଷେପଣ ହୋଇଛି । ନାସାର କେନେଡି ସେଣ୍ଟରରୁ  ଏହି ଉତକ୍ଷେପଣ
ହୋଇଥି ଲା ଫାଲକନ୍-9 ରକେଟ୍  ଦ୍ୱାରା ସଫଳ ଉତ୍ ‌କ୍ଷେପଣ ହୋଇଥି ଲା। ଏହି ଉତ୍ ‌କ୍ଷେପଣ ସହ ଗ୍ରୁ ପ କ୍ୟାପଟେନ୍
ଶୁଭାଂଶୁ ଶୁକ୍ଳା ମହାକାଶକୁ ଯାଇ ଭାରତ ପାଇଁ  ଗର୍ବ ଓ ଗୌରବ ଆଣିବା ସହ ମହାକାଶକୁ ଉଡ଼ାଣ ଭରି ଭାରତ ପାଇଁ  ଇତିହାସ
ରଚିଛନ୍ତି। ଦୀର୍ଘ 41 ବର୍ଷ ପରେ ସେ 2ୟ ଭାରତୀୟ ଭାବେ ମହାକାଶ ଯାତ୍ରା କରିଛନ୍ତି। 25 ଜୁନ 2025ରେ ଭାରତୀୟ ସମୟ
ଠିକ୍ ଦିନ 12ଟା 1ରେ ନାସାର କେନେଡୀ ସ୍ପେସ୍ ସେଣ୍ଟରରୁ  ଆକ୍ସିଓମ୍ ମିସନ-4 ଆରମ୍ଭ ହୋଇଥି ଲା। ସ୍ପେସ୍ ଏକ୍ସର ଆକ୍ସିଓମ୍
ମିସନ-4ର ଉତ୍ ‌କ୍ଷେପଣ ହୋଇଥି ଲା। 3 ମହାକାଶଚାରୀଙ୍କ ସହ ଅନ୍ତର୍ଜାତୀୟ ସ୍ପେସ୍ ଷ୍ଟେସନ୍ ଯାଇଛନ୍ତି ଭାରତୀୟ
ମହାକାଶଚାରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଲା। ପୂର୍ବରୁ  5 ଥର ମିଶନ ବାତିଲ କରାଯାଇଥି ଲା। କେବେ ଯାନ୍ତ୍ରିକ ତ୍ରୁଟି, ତ ପୁଣି କେବେ ଖରାପ
ପାଣିପାଗ ପାଇଁ  । ଭାରତୀୟ ବାୟୁ ସେନା ଗ୍ରୁ ପ୍ କ୍ୟାପ୍ଟେନ୍ ଶୁଭାଂଶୁ ଶୁକ୍ଲା ଏହି ଐତିହାସିକ ଯାତ୍ରାରେ ସାମିଲ ହୋଇ ପ୍ରଥମ
ଥର ପାଇଁ  ମହାକାଶକୁ ଯାଇଛନ୍ତି । ଏହାସହ ଦ୍ୱିତୀୟ ଭାରତୀୟ ଭାବେ ରେକର୍ଡ ସୃଷ୍ଟି  କରିଛନ୍ତି ଶୁଭାଂଶୁ । 140 କୋଟି
ଭାରତବାସୀଙ୍କ ପାଇଁ  ଗର୍ବ ଆଣିଛନ୍ତି ଅନ୍ତରୀକ୍ଷ ଯାତ୍ରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଳା। ମହାକାଶକୁ ଯାତ୍ରା କରିଥି ବା ଶୁଭାଂଶୁଙ୍କ ସହ
ପ୍ରଧାନମନ୍ତ୍ରୀ ମୋଦି କଥାବାର୍ତ୍ତା କରିଥି ଲେ। କଥାବାର୍ତ୍ତା ସମୟରେ ଇଣ୍ଟରନେଶନଲ୍  ସ୍ପେଶ୍ ସେଣ୍ଟରରୁ  ଶୁଭାଂଶୁ ନିଜ ଅଭିଜ୍ଞତା
ବଖାଣିଥି ଲେ। ମହାକାଶରୁ  ଭାରତ ଭବ୍ୟ ଦେଖାଯାଉଛି ବୋଲି ସେ କହିଥି ଲେ। 41 ବର୍ଷ ତଳେ ରାକେଶ ଶର୍ମା ପ୍ରଥମ
ଭାରତୀୟ ମହାକାଶଚାରୀ ଭାବେ ମହାକାଶ ଯାତ୍ରା କରି କହିଥି ଲେ - ସାରେ ଜାହାଁ  ସେ ଅଚ୍ଛା ହିନ୍ଦୁସ୍ତାଁ  ହମାରା। ଏହି ଅଭିଯାନ
ଭାରତ ପାଇଁ  ଗର୍ବର ବିଷୟ ହୋଇଥି ଲା, କାରଣ ଏହା ଭାରତୀୟ ଅନ୍ତରୀକ୍ଷ ଜ୍ଞାନକୌଶଳ ଏବଂ ମାନବ ଶକ୍ତିର ଗୁରୁ ତ୍ୱ
ଦେଖାଇଛି। ଆକ୍ସିଓମ୍-4 ମିଶନର ମୁଖ୍ୟ ଉଦ୍ଦେଶ୍ୟ ହେଉଛି ଅନ୍ତର୍ଜାତୀୟ ଅନ୍ତରୀକ୍ଷ କେନ୍ଦ୍ର (ISS) ରେ ବିଜ୍ଞାନ ଗବେଷଣା
କରିବା, ମାନବ ଶରୀର ଉପରେ ଅନ୍ତରୀକ୍ଷ ପରିବେଶର ପ୍ରଭାବ ଅଧ୍ୟୟନ କରିବା ଏବଂ ଭବିଷ୍ୟତରେ ଉତ୍କୃ ଷ୍ଟ ବେସରକାରୀ
ଅନ୍ତରିକ୍ଷ ଅଭିଯାନ ପାଇଁ  ତାଳମେଳ ବଢ଼େଇବା। 18 ଦିନ ମହାକାଶରେ ରହିବାପରେ 15 ଜୁଲାଇ 2025 ଦିନ ଶୁଭାଂଶୁ
ପୃଥି ବୀ ପୃଷ୍ଠ କୁ ଫେରି ଆସିଛନ୍ତି।

SubQuestion No : 76
Q.76 ଆକ୍ସିୟମ-4 ମିଶନର ସଫଳ ଉତକ୍ଷେପଣ କେବେ ହୋଇଥିଲା ?
Ans A. 25 ଅପ୍ରେଲ 2025

B. 14 ଜୁନ 2025

C. 13 ଜାନୁଆରୀ 2025

D. 25 ଜୁନ 2025

Question Type : MCQ
Question ID : 4410091078856
Option 1 ID : 4410094252743
Option 2 ID : 4410094252744
Option 3 ID : 4410094252742
Option 4 ID : 4410094252741

Status : Answered
Chosen Option : D
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Comprehension:

ନିମ୍ନ ଲିଖି ତ ଅନୁଚ୍ଛେଦର ବିଷୟବସ୍ତୁକୁ ଭଲଭାବରେ ପଢ଼ନ୍ତୁ। ତା’ତଳେ ପ୍ରଦତ୍ତ ପ୍ରତ୍ୟେକ ପ୍ରଶ୍ନର ଚାରୋଟି ସମ୍ଭାବିତ ଉତ୍ତର
ମଧ୍ୟରୁ  ସଠିକ ଉତ୍ତରକୁ ଚୟନ କରନ୍ତୁ ।

ସବୁ ଅପେକ୍ଷାର ଅନ୍ତ ଘଟିଥି ଲା ଏବଂ ଭାରତୀୟ ମହାକାଶଚାରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଳାଙ୍କ ମହାକାଶ ମିଶନ ଆରମ୍ଭ ହୋଇଥି ଲା।
ସ୍ପେସ୍ ଏକ୍ସର ଆକ୍ସିୟମ ମିଶନ-4ର ସଫଳ ଉତକ୍ଷେପଣ ହୋଇଛି । ନାସାର କେନେଡି ସେଣ୍ଟରରୁ  ଏହି ଉତକ୍ଷେପଣ
ହୋଇଥି ଲା ଫାଲକନ୍-9 ରକେଟ୍  ଦ୍ୱାରା ସଫଳ ଉତ୍ ‌କ୍ଷେପଣ ହୋଇଥି ଲା। ଏହି ଉତ୍ ‌କ୍ଷେପଣ ସହ ଗ୍ରୁ ପ କ୍ୟାପଟେନ୍
ଶୁଭାଂଶୁ ଶୁକ୍ଳା ମହାକାଶକୁ ଯାଇ ଭାରତ ପାଇଁ  ଗର୍ବ ଓ ଗୌରବ ଆଣିବା ସହ ମହାକାଶକୁ ଉଡ଼ାଣ ଭରି ଭାରତ ପାଇଁ  ଇତିହାସ
ରଚିଛନ୍ତି। ଦୀର୍ଘ 41 ବର୍ଷ ପରେ ସେ 2ୟ ଭାରତୀୟ ଭାବେ ମହାକାଶ ଯାତ୍ରା କରିଛନ୍ତି। 25 ଜୁନ 2025ରେ ଭାରତୀୟ ସମୟ
ଠିକ୍ ଦିନ 12ଟା 1ରେ ନାସାର କେନେଡୀ ସ୍ପେସ୍ ସେଣ୍ଟରରୁ  ଆକ୍ସିଓମ୍ ମିସନ-4 ଆରମ୍ଭ ହୋଇଥି ଲା। ସ୍ପେସ୍ ଏକ୍ସର ଆକ୍ସିଓମ୍
ମିସନ-4ର ଉତ୍ ‌କ୍ଷେପଣ ହୋଇଥି ଲା। 3 ମହାକାଶଚାରୀଙ୍କ ସହ ଅନ୍ତର୍ଜାତୀୟ ସ୍ପେସ୍ ଷ୍ଟେସନ୍ ଯାଇଛନ୍ତି ଭାରତୀୟ
ମହାକାଶଚାରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଲା। ପୂର୍ବରୁ  5 ଥର ମିଶନ ବାତିଲ କରାଯାଇଥି ଲା। କେବେ ଯାନ୍ତ୍ରିକ ତ୍ରୁଟି, ତ ପୁଣି କେବେ ଖରାପ
ପାଣିପାଗ ପାଇଁ  । ଭାରତୀୟ ବାୟୁ ସେନା ଗ୍ରୁ ପ୍ କ୍ୟାପ୍ଟେନ୍ ଶୁଭାଂଶୁ ଶୁକ୍ଲା ଏହି ଐତିହାସିକ ଯାତ୍ରାରେ ସାମିଲ ହୋଇ ପ୍ରଥମ
ଥର ପାଇଁ  ମହାକାଶକୁ ଯାଇଛନ୍ତି । ଏହାସହ ଦ୍ୱିତୀୟ ଭାରତୀୟ ଭାବେ ରେକର୍ଡ ସୃଷ୍ଟି  କରିଛନ୍ତି ଶୁଭାଂଶୁ । 140 କୋଟି
ଭାରତବାସୀଙ୍କ ପାଇଁ  ଗର୍ବ ଆଣିଛନ୍ତି ଅନ୍ତରୀକ୍ଷ ଯାତ୍ରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଳା। ମହାକାଶକୁ ଯାତ୍ରା କରିଥି ବା ଶୁଭାଂଶୁଙ୍କ ସହ
ପ୍ରଧାନମନ୍ତ୍ରୀ ମୋଦି କଥାବାର୍ତ୍ତା କରିଥି ଲେ। କଥାବାର୍ତ୍ତା ସମୟରେ ଇଣ୍ଟରନେଶନଲ୍  ସ୍ପେଶ୍ ସେଣ୍ଟରରୁ  ଶୁଭାଂଶୁ ନିଜ ଅଭିଜ୍ଞତା
ବଖାଣିଥି ଲେ। ମହାକାଶରୁ  ଭାରତ ଭବ୍ୟ ଦେଖାଯାଉଛି ବୋଲି ସେ କହିଥି ଲେ। 41 ବର୍ଷ ତଳେ ରାକେଶ ଶର୍ମା ପ୍ରଥମ
ଭାରତୀୟ ମହାକାଶଚାରୀ ଭାବେ ମହାକାଶ ଯାତ୍ରା କରି କହିଥି ଲେ - ସାରେ ଜାହାଁ  ସେ ଅଚ୍ଛା ହିନ୍ଦୁସ୍ତାଁ  ହମାରା। ଏହି ଅଭିଯାନ
ଭାରତ ପାଇଁ  ଗର୍ବର ବିଷୟ ହୋଇଥି ଲା, କାରଣ ଏହା ଭାରତୀୟ ଅନ୍ତରୀକ୍ଷ ଜ୍ଞାନକୌଶଳ ଏବଂ ମାନବ ଶକ୍ତିର ଗୁରୁ ତ୍ୱ
ଦେଖାଇଛି। ଆକ୍ସିଓମ୍-4 ମିଶନର ମୁଖ୍ୟ ଉଦ୍ଦେଶ୍ୟ ହେଉଛି ଅନ୍ତର୍ଜାତୀୟ ଅନ୍ତରୀକ୍ଷ କେନ୍ଦ୍ର (ISS) ରେ ବିଜ୍ଞାନ ଗବେଷଣା
କରିବା, ମାନବ ଶରୀର ଉପରେ ଅନ୍ତରୀକ୍ଷ ପରିବେଶର ପ୍ରଭାବ ଅଧ୍ୟୟନ କରିବା ଏବଂ ଭବିଷ୍ୟତରେ ଉତ୍କୃ ଷ୍ଟ ବେସରକାରୀ
ଅନ୍ତରିକ୍ଷ ଅଭିଯାନ ପାଇଁ  ତାଳମେଳ ବଢ଼େଇବା। 18 ଦିନ ମହାକାଶରେ ରହିବାପରେ 15 ଜୁଲାଇ 2025 ଦିନ ଶୁଭାଂଶୁ
ପୃଥି ବୀ ପୃଷ୍ଠ କୁ ଫେରି ଆସିଛନ୍ତି।

SubQuestion No : 77
Q.77 ଏହି ମିଶନ କେଉଁ  କମ୍ପାନୀ ଦ୍ୱାରା ଚାଲିଥିଲା ?
Ans A. Axiom Space

B. ISRO

C. Blue Origin

D. NASA

Question Type : MCQ
Question ID : 4410091078857
Option 1 ID : 4410094252747
Option 2 ID : 4410094252745
Option 3 ID : 4410094252748
Option 4 ID : 4410094252746

Status : Answered
Chosen Option : D
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Comprehension:

ନିମ୍ନ ଲିଖି ତ ଅନୁଚ୍ଛେଦର ବିଷୟବସ୍ତୁକୁ ଭଲଭାବରେ ପଢ଼ନ୍ତୁ। ତା’ତଳେ ପ୍ରଦତ୍ତ ପ୍ରତ୍ୟେକ ପ୍ରଶ୍ନର ଚାରୋଟି ସମ୍ଭାବିତ ଉତ୍ତର
ମଧ୍ୟରୁ  ସଠିକ ଉତ୍ତରକୁ ଚୟନ କରନ୍ତୁ ।

ସବୁ ଅପେକ୍ଷାର ଅନ୍ତ ଘଟିଥି ଲା ଏବଂ ଭାରତୀୟ ମହାକାଶଚାରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଳାଙ୍କ ମହାକାଶ ମିଶନ ଆରମ୍ଭ ହୋଇଥି ଲା।
ସ୍ପେସ୍ ଏକ୍ସର ଆକ୍ସିୟମ ମିଶନ-4ର ସଫଳ ଉତକ୍ଷେପଣ ହୋଇଛି । ନାସାର କେନେଡି ସେଣ୍ଟରରୁ  ଏହି ଉତକ୍ଷେପଣ
ହୋଇଥି ଲା ଫାଲକନ୍-9 ରକେଟ୍  ଦ୍ୱାରା ସଫଳ ଉତ୍ ‌କ୍ଷେପଣ ହୋଇଥି ଲା। ଏହି ଉତ୍ ‌କ୍ଷେପଣ ସହ ଗ୍ରୁ ପ କ୍ୟାପଟେନ୍
ଶୁଭାଂଶୁ ଶୁକ୍ଳା ମହାକାଶକୁ ଯାଇ ଭାରତ ପାଇଁ  ଗର୍ବ ଓ ଗୌରବ ଆଣିବା ସହ ମହାକାଶକୁ ଉଡ଼ାଣ ଭରି ଭାରତ ପାଇଁ  ଇତିହାସ
ରଚିଛନ୍ତି। ଦୀର୍ଘ 41 ବର୍ଷ ପରେ ସେ 2ୟ ଭାରତୀୟ ଭାବେ ମହାକାଶ ଯାତ୍ରା କରିଛନ୍ତି। 25 ଜୁନ 2025ରେ ଭାରତୀୟ ସମୟ
ଠିକ୍ ଦିନ 12ଟା 1ରେ ନାସାର କେନେଡୀ ସ୍ପେସ୍ ସେଣ୍ଟରରୁ  ଆକ୍ସିଓମ୍ ମିସନ-4 ଆରମ୍ଭ ହୋଇଥି ଲା। ସ୍ପେସ୍ ଏକ୍ସର ଆକ୍ସିଓମ୍
ମିସନ-4ର ଉତ୍ ‌କ୍ଷେପଣ ହୋଇଥି ଲା। 3 ମହାକାଶଚାରୀଙ୍କ ସହ ଅନ୍ତର୍ଜାତୀୟ ସ୍ପେସ୍ ଷ୍ଟେସନ୍ ଯାଇଛନ୍ତି ଭାରତୀୟ
ମହାକାଶଚାରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଲା। ପୂର୍ବରୁ  5 ଥର ମିଶନ ବାତିଲ କରାଯାଇଥି ଲା। କେବେ ଯାନ୍ତ୍ରିକ ତ୍ରୁଟି, ତ ପୁଣି କେବେ ଖରାପ
ପାଣିପାଗ ପାଇଁ  । ଭାରତୀୟ ବାୟୁ ସେନା ଗ୍ରୁ ପ୍ କ୍ୟାପ୍ଟେନ୍ ଶୁଭାଂଶୁ ଶୁକ୍ଲା ଏହି ଐତିହାସିକ ଯାତ୍ରାରେ ସାମିଲ ହୋଇ ପ୍ରଥମ
ଥର ପାଇଁ  ମହାକାଶକୁ ଯାଇଛନ୍ତି । ଏହାସହ ଦ୍ୱିତୀୟ ଭାରତୀୟ ଭାବେ ରେକର୍ଡ ସୃଷ୍ଟି  କରିଛନ୍ତି ଶୁଭାଂଶୁ । 140 କୋଟି
ଭାରତବାସୀଙ୍କ ପାଇଁ  ଗର୍ବ ଆଣିଛନ୍ତି ଅନ୍ତରୀକ୍ଷ ଯାତ୍ରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଳା। ମହାକାଶକୁ ଯାତ୍ରା କରିଥି ବା ଶୁଭାଂଶୁଙ୍କ ସହ
ପ୍ରଧାନମନ୍ତ୍ରୀ ମୋଦି କଥାବାର୍ତ୍ତା କରିଥି ଲେ। କଥାବାର୍ତ୍ତା ସମୟରେ ଇଣ୍ଟରନେଶନଲ୍  ସ୍ପେଶ୍ ସେଣ୍ଟରରୁ  ଶୁଭାଂଶୁ ନିଜ ଅଭିଜ୍ଞତା
ବଖାଣିଥି ଲେ। ମହାକାଶରୁ  ଭାରତ ଭବ୍ୟ ଦେଖାଯାଉଛି ବୋଲି ସେ କହିଥି ଲେ। 41 ବର୍ଷ ତଳେ ରାକେଶ ଶର୍ମା ପ୍ରଥମ
ଭାରତୀୟ ମହାକାଶଚାରୀ ଭାବେ ମହାକାଶ ଯାତ୍ରା କରି କହିଥି ଲେ - ସାରେ ଜାହାଁ  ସେ ଅଚ୍ଛା ହିନ୍ଦୁସ୍ତାଁ  ହମାରା। ଏହି ଅଭିଯାନ
ଭାରତ ପାଇଁ  ଗର୍ବର ବିଷୟ ହୋଇଥି ଲା, କାରଣ ଏହା ଭାରତୀୟ ଅନ୍ତରୀକ୍ଷ ଜ୍ଞାନକୌଶଳ ଏବଂ ମାନବ ଶକ୍ତିର ଗୁରୁ ତ୍ୱ
ଦେଖାଇଛି। ଆକ୍ସିଓମ୍-4 ମିଶନର ମୁଖ୍ୟ ଉଦ୍ଦେଶ୍ୟ ହେଉଛି ଅନ୍ତର୍ଜାତୀୟ ଅନ୍ତରୀକ୍ଷ କେନ୍ଦ୍ର (ISS) ରେ ବିଜ୍ଞାନ ଗବେଷଣା
କରିବା, ମାନବ ଶରୀର ଉପରେ ଅନ୍ତରୀକ୍ଷ ପରିବେଶର ପ୍ରଭାବ ଅଧ୍ୟୟନ କରିବା ଏବଂ ଭବିଷ୍ୟତରେ ଉତ୍କୃ ଷ୍ଟ ବେସରକାରୀ
ଅନ୍ତରିକ୍ଷ ଅଭିଯାନ ପାଇଁ  ତାଳମେଳ ବଢ଼େଇବା। 18 ଦିନ ମହାକାଶରେ ରହିବାପରେ 15 ଜୁଲାଇ 2025 ଦିନ ଶୁଭାଂଶୁ
ପୃଥି ବୀ ପୃଷ୍ଠ କୁ ଫେରି ଆସିଛନ୍ତି।

SubQuestion No : 78
Q.78 2025 ରେ କେଉଁ  ଭାରତୀୟ ମହାକାଶଚାରୀ ମହାକାଶ ଯାତ୍ରା କରିଥିଲେ ?
Ans A. ଶୁଭାଂଶୁ ଶୁକ୍ଳା

B. ରାକେଶ ଶର୍ମା

C. ପ୍ରଶାନ୍ତ ନୟକ

D. ଅଭିନନ୍ଦନ ଭର୍ତ୍ତମାନ

Question Type : MCQ
Question ID : 4410091078858
Option 1 ID : 4410094252752
Option 2 ID : 4410094252749
Option 3 ID : 4410094252751
Option 4 ID : 4410094252750

Status : Answered
Chosen Option : A
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Comprehension:

ନିମ୍ନ ଲିଖି ତ ଅନୁଚ୍ଛେଦର ବିଷୟବସ୍ତୁକୁ ଭଲଭାବରେ ପଢ଼ନ୍ତୁ। ତା’ତଳେ ପ୍ରଦତ୍ତ ପ୍ରତ୍ୟେକ ପ୍ରଶ୍ନର ଚାରୋଟି ସମ୍ଭାବିତ ଉତ୍ତର
ମଧ୍ୟରୁ  ସଠିକ ଉତ୍ତରକୁ ଚୟନ କରନ୍ତୁ ।

ସବୁ ଅପେକ୍ଷାର ଅନ୍ତ ଘଟିଥି ଲା ଏବଂ ଭାରତୀୟ ମହାକାଶଚାରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଳାଙ୍କ ମହାକାଶ ମିଶନ ଆରମ୍ଭ ହୋଇଥି ଲା।
ସ୍ପେସ୍ ଏକ୍ସର ଆକ୍ସିୟମ ମିଶନ-4ର ସଫଳ ଉତକ୍ଷେପଣ ହୋଇଛି । ନାସାର କେନେଡି ସେଣ୍ଟରରୁ  ଏହି ଉତକ୍ଷେପଣ
ହୋଇଥି ଲା ଫାଲକନ୍-9 ରକେଟ୍  ଦ୍ୱାରା ସଫଳ ଉତ୍ ‌କ୍ଷେପଣ ହୋଇଥି ଲା। ଏହି ଉତ୍ ‌କ୍ଷେପଣ ସହ ଗ୍ରୁ ପ କ୍ୟାପଟେନ୍
ଶୁଭାଂଶୁ ଶୁକ୍ଳା ମହାକାଶକୁ ଯାଇ ଭାରତ ପାଇଁ  ଗର୍ବ ଓ ଗୌରବ ଆଣିବା ସହ ମହାକାଶକୁ ଉଡ଼ାଣ ଭରି ଭାରତ ପାଇଁ  ଇତିହାସ
ରଚିଛନ୍ତି। ଦୀର୍ଘ 41 ବର୍ଷ ପରେ ସେ 2ୟ ଭାରତୀୟ ଭାବେ ମହାକାଶ ଯାତ୍ରା କରିଛନ୍ତି। 25 ଜୁନ 2025ରେ ଭାରତୀୟ ସମୟ
ଠିକ୍ ଦିନ 12ଟା 1ରେ ନାସାର କେନେଡୀ ସ୍ପେସ୍ ସେଣ୍ଟରରୁ  ଆକ୍ସିଓମ୍ ମିସନ-4 ଆରମ୍ଭ ହୋଇଥି ଲା। ସ୍ପେସ୍ ଏକ୍ସର ଆକ୍ସିଓମ୍
ମିସନ-4ର ଉତ୍ ‌କ୍ଷେପଣ ହୋଇଥି ଲା। 3 ମହାକାଶଚାରୀଙ୍କ ସହ ଅନ୍ତର୍ଜାତୀୟ ସ୍ପେସ୍ ଷ୍ଟେସନ୍ ଯାଇଛନ୍ତି ଭାରତୀୟ
ମହାକାଶଚାରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଲା। ପୂର୍ବରୁ  5 ଥର ମିଶନ ବାତିଲ କରାଯାଇଥି ଲା। କେବେ ଯାନ୍ତ୍ରିକ ତ୍ରୁଟି, ତ ପୁଣି କେବେ ଖରାପ
ପାଣିପାଗ ପାଇଁ  । ଭାରତୀୟ ବାୟୁ ସେନା ଗ୍ରୁ ପ୍ କ୍ୟାପ୍ଟେନ୍ ଶୁଭାଂଶୁ ଶୁକ୍ଲା ଏହି ଐତିହାସିକ ଯାତ୍ରାରେ ସାମିଲ ହୋଇ ପ୍ରଥମ
ଥର ପାଇଁ  ମହାକାଶକୁ ଯାଇଛନ୍ତି । ଏହାସହ ଦ୍ୱିତୀୟ ଭାରତୀୟ ଭାବେ ରେକର୍ଡ ସୃଷ୍ଟି  କରିଛନ୍ତି ଶୁଭାଂଶୁ । 140 କୋଟି
ଭାରତବାସୀଙ୍କ ପାଇଁ  ଗର୍ବ ଆଣିଛନ୍ତି ଅନ୍ତରୀକ୍ଷ ଯାତ୍ରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଳା। ମହାକାଶକୁ ଯାତ୍ରା କରିଥି ବା ଶୁଭାଂଶୁଙ୍କ ସହ
ପ୍ରଧାନମନ୍ତ୍ରୀ ମୋଦି କଥାବାର୍ତ୍ତା କରିଥି ଲେ। କଥାବାର୍ତ୍ତା ସମୟରେ ଇଣ୍ଟରନେଶନଲ୍  ସ୍ପେଶ୍ ସେଣ୍ଟରରୁ  ଶୁଭାଂଶୁ ନିଜ ଅଭିଜ୍ଞତା
ବଖାଣିଥି ଲେ। ମହାକାଶରୁ  ଭାରତ ଭବ୍ୟ ଦେଖାଯାଉଛି ବୋଲି ସେ କହିଥି ଲେ। 41 ବର୍ଷ ତଳେ ରାକେଶ ଶର୍ମା ପ୍ରଥମ
ଭାରତୀୟ ମହାକାଶଚାରୀ ଭାବେ ମହାକାଶ ଯାତ୍ରା କରି କହିଥି ଲେ - ସାରେ ଜାହାଁ  ସେ ଅଚ୍ଛା ହିନ୍ଦୁସ୍ତାଁ  ହମାରା। ଏହି ଅଭିଯାନ
ଭାରତ ପାଇଁ  ଗର୍ବର ବିଷୟ ହୋଇଥି ଲା, କାରଣ ଏହା ଭାରତୀୟ ଅନ୍ତରୀକ୍ଷ ଜ୍ଞାନକୌଶଳ ଏବଂ ମାନବ ଶକ୍ତିର ଗୁରୁ ତ୍ୱ
ଦେଖାଇଛି। ଆକ୍ସିଓମ୍-4 ମିଶନର ମୁଖ୍ୟ ଉଦ୍ଦେଶ୍ୟ ହେଉଛି ଅନ୍ତର୍ଜାତୀୟ ଅନ୍ତରୀକ୍ଷ କେନ୍ଦ୍ର (ISS) ରେ ବିଜ୍ଞାନ ଗବେଷଣା
କରିବା, ମାନବ ଶରୀର ଉପରେ ଅନ୍ତରୀକ୍ଷ ପରିବେଶର ପ୍ରଭାବ ଅଧ୍ୟୟନ କରିବା ଏବଂ ଭବିଷ୍ୟତରେ ଉତ୍କୃ ଷ୍ଟ ବେସରକାରୀ
ଅନ୍ତରିକ୍ଷ ଅଭିଯାନ ପାଇଁ  ତାଳମେଳ ବଢ଼େଇବା। 18 ଦିନ ମହାକାଶରେ ରହିବାପରେ 15 ଜୁଲାଇ 2025 ଦିନ ଶୁଭାଂଶୁ
ପୃଥି ବୀ ପୃଷ୍ଠ କୁ ଫେରି ଆସିଛନ୍ତି।

SubQuestion No : 79
Q.79 ଏହି ମିଶନ କେଉଁ  ରକେଟ ମାଧ୍ୟମରେ ପଠାଯାଇଥିଲା ?
Ans A. PSLV

B. GSLV

C. Falcon 9

D. Soyuz

Question Type : MCQ
Question ID : 4410091078859
Option 1 ID : 4410094252753
Option 2 ID : 4410094252754
Option 3 ID : 4410094252755
Option 4 ID : 4410094252756

Status : Answered
Chosen Option : C
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Comprehension:

ନିମ୍ନ ଲିଖି ତ ଅନୁଚ୍ଛେଦର ବିଷୟବସ୍ତୁକୁ ଭଲଭାବରେ ପଢ଼ନ୍ତୁ। ତା’ତଳେ ପ୍ରଦତ୍ତ ପ୍ରତ୍ୟେକ ପ୍ରଶ୍ନର ଚାରୋଟି ସମ୍ଭାବିତ ଉତ୍ତର
ମଧ୍ୟରୁ  ସଠିକ ଉତ୍ତରକୁ ଚୟନ କରନ୍ତୁ ।

ସବୁ ଅପେକ୍ଷାର ଅନ୍ତ ଘଟିଥି ଲା ଏବଂ ଭାରତୀୟ ମହାକାଶଚାରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଳାଙ୍କ ମହାକାଶ ମିଶନ ଆରମ୍ଭ ହୋଇଥି ଲା।
ସ୍ପେସ୍ ଏକ୍ସର ଆକ୍ସିୟମ ମିଶନ-4ର ସଫଳ ଉତକ୍ଷେପଣ ହୋଇଛି । ନାସାର କେନେଡି ସେଣ୍ଟରରୁ  ଏହି ଉତକ୍ଷେପଣ
ହୋଇଥି ଲା ଫାଲକନ୍-9 ରକେଟ୍  ଦ୍ୱାରା ସଫଳ ଉତ୍ ‌କ୍ଷେପଣ ହୋଇଥି ଲା। ଏହି ଉତ୍ ‌କ୍ଷେପଣ ସହ ଗ୍ରୁ ପ କ୍ୟାପଟେନ୍
ଶୁଭାଂଶୁ ଶୁକ୍ଳା ମହାକାଶକୁ ଯାଇ ଭାରତ ପାଇଁ  ଗର୍ବ ଓ ଗୌରବ ଆଣିବା ସହ ମହାକାଶକୁ ଉଡ଼ାଣ ଭରି ଭାରତ ପାଇଁ  ଇତିହାସ
ରଚିଛନ୍ତି। ଦୀର୍ଘ 41 ବର୍ଷ ପରେ ସେ 2ୟ ଭାରତୀୟ ଭାବେ ମହାକାଶ ଯାତ୍ରା କରିଛନ୍ତି। 25 ଜୁନ 2025ରେ ଭାରତୀୟ ସମୟ
ଠିକ୍ ଦିନ 12ଟା 1ରେ ନାସାର କେନେଡୀ ସ୍ପେସ୍ ସେଣ୍ଟରରୁ  ଆକ୍ସିଓମ୍ ମିସନ-4 ଆରମ୍ଭ ହୋଇଥି ଲା। ସ୍ପେସ୍ ଏକ୍ସର ଆକ୍ସିଓମ୍
ମିସନ-4ର ଉତ୍ ‌କ୍ଷେପଣ ହୋଇଥି ଲା। 3 ମହାକାଶଚାରୀଙ୍କ ସହ ଅନ୍ତର୍ଜାତୀୟ ସ୍ପେସ୍ ଷ୍ଟେସନ୍ ଯାଇଛନ୍ତି ଭାରତୀୟ
ମହାକାଶଚାରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଲା। ପୂର୍ବରୁ  5 ଥର ମିଶନ ବାତିଲ କରାଯାଇଥି ଲା। କେବେ ଯାନ୍ତ୍ରିକ ତ୍ରୁଟି, ତ ପୁଣି କେବେ ଖରାପ
ପାଣିପାଗ ପାଇଁ  । ଭାରତୀୟ ବାୟୁ ସେନା ଗ୍ରୁ ପ୍ କ୍ୟାପ୍ଟେନ୍ ଶୁଭାଂଶୁ ଶୁକ୍ଲା ଏହି ଐତିହାସିକ ଯାତ୍ରାରେ ସାମିଲ ହୋଇ ପ୍ରଥମ
ଥର ପାଇଁ  ମହାକାଶକୁ ଯାଇଛନ୍ତି । ଏହାସହ ଦ୍ୱିତୀୟ ଭାରତୀୟ ଭାବେ ରେକର୍ଡ ସୃଷ୍ଟି  କରିଛନ୍ତି ଶୁଭାଂଶୁ । 140 କୋଟି
ଭାରତବାସୀଙ୍କ ପାଇଁ  ଗର୍ବ ଆଣିଛନ୍ତି ଅନ୍ତରୀକ୍ଷ ଯାତ୍ରୀ ଶୁଭାଂଶୁ ଶୁକ୍ଳା। ମହାକାଶକୁ ଯାତ୍ରା କରିଥି ବା ଶୁଭାଂଶୁଙ୍କ ସହ
ପ୍ରଧାନମନ୍ତ୍ରୀ ମୋଦି କଥାବାର୍ତ୍ତା କରିଥି ଲେ। କଥାବାର୍ତ୍ତା ସମୟରେ ଇଣ୍ଟରନେଶନଲ୍  ସ୍ପେଶ୍ ସେଣ୍ଟରରୁ  ଶୁଭାଂଶୁ ନିଜ ଅଭିଜ୍ଞତା
ବଖାଣିଥି ଲେ। ମହାକାଶରୁ  ଭାରତ ଭବ୍ୟ ଦେଖାଯାଉଛି ବୋଲି ସେ କହିଥି ଲେ। 41 ବର୍ଷ ତଳେ ରାକେଶ ଶର୍ମା ପ୍ରଥମ
ଭାରତୀୟ ମହାକାଶଚାରୀ ଭାବେ ମହାକାଶ ଯାତ୍ରା କରି କହିଥି ଲେ - ସାରେ ଜାହାଁ  ସେ ଅଚ୍ଛା ହିନ୍ଦୁସ୍ତାଁ  ହମାରା। ଏହି ଅଭିଯାନ
ଭାରତ ପାଇଁ  ଗର୍ବର ବିଷୟ ହୋଇଥି ଲା, କାରଣ ଏହା ଭାରତୀୟ ଅନ୍ତରୀକ୍ଷ ଜ୍ଞାନକୌଶଳ ଏବଂ ମାନବ ଶକ୍ତିର ଗୁରୁ ତ୍ୱ
ଦେଖାଇଛି। ଆକ୍ସିଓମ୍-4 ମିଶନର ମୁଖ୍ୟ ଉଦ୍ଦେଶ୍ୟ ହେଉଛି ଅନ୍ତର୍ଜାତୀୟ ଅନ୍ତରୀକ୍ଷ କେନ୍ଦ୍ର (ISS) ରେ ବିଜ୍ଞାନ ଗବେଷଣା
କରିବା, ମାନବ ଶରୀର ଉପରେ ଅନ୍ତରୀକ୍ଷ ପରିବେଶର ପ୍ରଭାବ ଅଧ୍ୟୟନ କରିବା ଏବଂ ଭବିଷ୍ୟତରେ ଉତ୍କୃ ଷ୍ଟ ବେସରକାରୀ
ଅନ୍ତରିକ୍ଷ ଅଭିଯାନ ପାଇଁ  ତାଳମେଳ ବଢ଼େଇବା। 18 ଦିନ ମହାକାଶରେ ରହିବାପରେ 15 ଜୁଲାଇ 2025 ଦିନ ଶୁଭାଂଶୁ
ପୃଥି ବୀ ପୃଷ୍ଠ କୁ ଫେରି ଆସିଛନ୍ତି।

SubQuestion No : 80
Q.80 ଏହି ମିଶନର ମୁଖ୍ୟ ଉଦ୍ଦେଶ୍ୟ କ’ଣ ଥିଲା ?
Ans A. ଉପଗ୍ରହ ପ୍ରକ୍ଷେପଣ

B. ଅନ୍ତରୀକ୍ଷରେ ଗବେଷଣା କାର୍ଯ୍ୟ

C. ଚନ୍ଦ୍ର ଅଭିଯାନ

D. ଦୂରଦର୍ଶନ ସେବା

Question Type : MCQ
Question ID : 4410091078860
Option 1 ID : 4410094252759
Option 2 ID : 4410094252758
Option 3 ID : 4410094252757
Option 4 ID : 4410094252760

Status : Answered
Chosen Option : B
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Q.81 In context of securing smartphone, match the Security Practices in Column A with their
correct Descriptions in Column B:

Column A – Security
Practice Column B – Description

1. Installing Apps from Official
Stores

a) Ensures downloaded applications are legitimate and
helps reduce malware infections.

2. Using Strong Passwords or
Biometrics

b) Safeguards the phone from unauthorized entry or
misuse.

3. Enabling Automatic Software
Updates

c) Keeps the device protected by installing the newest
security updates and bug fixes.

4. Avoiding Public Wi-Fi for
Sensitive Tasks

d) Reduces the chances of personal data being intercepted
on insecure networks.

Ans A. 1–a, 2–b, 3–c, 4–d

B. 1–d, 2–c, 3–a, 4–b

C. 1–c, 2–d, 3–b, 4–a

D. 1–a, 2–b, 3–d, 4–c

Question Type : MCQ
Question ID : 4410091477504
Option 1 ID : 4410095837403
Option 2 ID : 4410095837406
Option 3 ID : 4410095837405
Option 4 ID : 4410095837404

Status : Answered
Chosen Option : C

Q.82 Which of the following keyboard shortcuts is used to save changes to an existing
workbook in Excel 365?

Ans A. Ctrl + N

B. Ctrl + O

C. Ctrl + S

D. Ctrl + W

Question Type : MCQ
Question ID : 4410091452287
Option 1 ID : 4410095737548
Option 2 ID : 4410095737549
Option 3 ID : 4410095737550
Option 4 ID : 4410095737551

Status : Answered
Chosen Option : C
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Q.83 A financial analyst needs to create a new Excel workbook that contains custom
formulas, formatting, and a specific company logo, which will be used as a
standardized blueprint to create dozens of new monthly reports.
To save this blueprint file so it can be repeatedly opened to create a new, unsaved copy
of the report structure without altering the original, which file extension should the
analyst choose?

Ans A. .xlsm

B. .xltx

C. .xlsx

D. .xlsb

Question Type : MCQ
Question ID : 4410091430961
Option 1 ID : 4410095652153
Option 2 ID : 4410095652152
Option 3 ID : 4410095652155
Option 4 ID : 4410095652154

Status : Answered
Chosen Option : C

Q.84 Which feature in MS Excel 365 allows row headers (e.g., column titles) to appear on
every printed page?

Ans A. Page Layout → Print Titles

B. File → Print → Header/Footer

C. Page Layout → Print Area

D. View → Freeze Panes

Question Type : MCQ
Question ID : 4410091445864
Option 1 ID : 4410095712106
Option 2 ID : 4410095712107
Option 3 ID : 4410095712105
Option 4 ID : 4410095712108

Status : Not Answered
Chosen Option : --

Q.85 Which of the following is an example of a modern antivirus program that provides real-
time protection and cloud-based scanning?

Ans A. CorelDRAW ​​​​​​

B. Avast One

C. Microsoft Excel

D. Adobe Acrobat

Question Type : MCQ
Question ID : 4410091467415
Option 1 ID : 4410095797598
Option 2 ID : 4410095797596
Option 3 ID : 4410095797595
Option 4 ID : 4410095797597

Status : Answered
Chosen Option : A
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Q.86 Which feature in MS Word 2020 allows you to find a word or phrase and replace it
throughout the document?

Ans A. Undo

B. Cut and Paste

C. Find and Replace

D. Format Painter

Question Type : MCQ
Question ID : 4410091447681
Option 1 ID : 4410095719332
Option 2 ID : 4410095719331
Option 3 ID : 4410095719330
Option 4 ID : 4410095719333

Status : Answered
Chosen Option : C

Q.87 When making digital presentations, which of the following programs is most frequently
used?

Ans A. Adobe Photoshop

B. Microsoft Excel

C. Microsoft Word

D. Microsoft PowerPoint

Question Type : MCQ
Question ID : 4410091439347
Option 1 ID : 4410095686063
Option 2 ID : 4410095686062
Option 3 ID : 4410095686060
Option 4 ID : 4410095686061

Status : Answered
Chosen Option : D

Q.88 What does the Rehearse Timings feature in MS PowerPoint 2021 do?
Ans A. Lets you practice and record the time spent on each slide

B. Creates speaker notes automatically

C. Plays animations faster

D. Records narration audio

Question Type : MCQ
Question ID : 4410091450774
Option 1 ID : 4410095731549
Option 2 ID : 4410095731551
Option 3 ID : 4410095731550
Option 4 ID : 4410095731548

Status : Answered
Chosen Option : A
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Q.89 Identify the type of icons that represent Recycle Bin, Network, and Control Panel.
Ans A. Task bar

B. File icons

C. System icons

D. Shortcut icons

Question Type : MCQ
Question ID : 4410091450847
Option 1 ID : 4410095731842
Option 2 ID : 4410095731845
Option 3 ID : 4410095731843
Option 4 ID : 4410095731844

Status : Answered
Chosen Option : C

Q.90 In context of editing text in MS word 2021, match the Actions in Column A with their
correct descriptions in Column B:

Column
A Column B

1. Text Box a) Removes the selected text and places it on the clipboard for relocation

2. Ctrl + C b) Inserts a container where users can type or position text on a word
documents

3. Ctrl + X c) Copies the chosen text or object to the clipboard

4. Delete Key d) Erases the selected text, object, or content from the documents

Ans A. 1–d, 2–b, 3–c, 4–a

B. 1–b, 2–c, 3–a, 4–d

C. 1–a, 2–d, 3–b, 4–c

D. 1–c, 2–a, 3–d, 4–b

Question Type : MCQ
Question ID : 4410091468368
Option 1 ID : 4410095801355
Option 2 ID : 4410095801353
Option 3 ID : 4410095801356
Option 4 ID : 4410095801354

Status : Answered
Chosen Option : B

Q.91 What is the correct sequence to reach Gmail’s spelling check settings on a computer?
Ans A. Open Gmail → Click Inbox → Click Spelling

B. Open Gmail → Settings → See all settings → General → Change Spelling setting

C. Open Gmail → Help → Grammar settings

D. Open Gmail → Click Compose → Click Grammar

Question Type : MCQ
Question ID : 4410091462455
Option 1 ID : 4410095777932
Option 2 ID : 4410095777931
Option 3 ID : 4410095777933
Option 4 ID : 4410095777930

Status : Not Answered
Chosen Option : --
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Q.92 Which of the following is a type of primary memory?
Ans A. RAM

B. CD-ROM

C. Hard Disk

D. USB Drive

Question Type : MCQ
Question ID : 4410091426516
Option 1 ID : 4410095634644
Option 2 ID : 4410095634645
Option 3 ID : 4410095634643
Option 4 ID : 4410095634646

Status : Answered
Chosen Option : A

Q.93 Which feature in an email client is used to store messages temporarily before they are
dispatched?

Ans A. Trash

B. Inbox

C. Outbox

D. Sent

Question Type : MCQ
Question ID : 4410091478568
Option 1 ID : 4410095841606
Option 2 ID : 4410095841603
Option 3 ID : 4410095841604
Option 4 ID : 4410095841605

Status : Answered
Chosen Option : C

Q.94 Which of the following is an example of application software?
Ans A. Windows

B. Linux

C. MS Word

D. BIOS

Question Type : MCQ
Question ID : 4410091441332
Option 1 ID : 4410095693979
Option 2 ID : 4410095693981
Option 3 ID : 4410095693980
Option 4 ID : 4410095693982

Status : Answered
Chosen Option : C
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Q.95 Which of the following is an example of a computer application?
Ans A. Painting walls manually

B. Riding a bicycle

C. Hammering nails

D. Word Processing

Question Type : MCQ
Question ID : 4410091446705
Option 1 ID : 4410095715484
Option 2 ID : 4410095715485
Option 3 ID : 4410095715483
Option 4 ID : 4410095715482

Status : Answered
Chosen Option : D

Q.96 Which file type is commonly used for inserting sound in PowerPoint?
Ans A. .pdf

B. .mp3

C. .exe

D. .dot

Question Type : MCQ
Question ID : 4410091449089
Option 1 ID : 4410095724818
Option 2 ID : 4410095724816
Option 3 ID : 4410095724817
Option 4 ID : 4410095724819

Status : Answered
Chosen Option : B

Q.97 In Windows 11, what does the term running an application mean?
Ans A. Executing or opening the application so it can perform its tasks

B. Installing the application on the computer

C. Deleting the application permanently

D. Minimizing the application to the taskbar

Question Type : MCQ
Question ID : 4410091450120
Option 1 ID : 4410095728989
Option 2 ID : 4410095728988
Option 3 ID : 4410095728991
Option 4 ID : 4410095728990

Status : Answered
Chosen Option : D
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Q.98 What does Cyber Ethics refer to?
Ans A. Legal rules made by the government

B. Code of responsible behaviour on the Internet

C. Internet connection speed

D. Computer programming rules

Question Type : MCQ
Question ID : 4410091448988
Option 1 ID : 4410095724426
Option 2 ID : 4410095724425
Option 3 ID : 4410095724427
Option 4 ID : 4410095724424

Status : Answered
Chosen Option : A

Q.99 What is the primary function of File Explorer in Windows 11?
Ans A. Manage and monitor system performance

B. Configure network devices and connections

C. Provide access to and organize files, folders, and drives on your computer

D. Update Windows security and software settings

Question Type : MCQ
Question ID : 4410091438071
Option 1 ID : 4410095680981
Option 2 ID : 4410095680984
Option 3 ID : 4410095680982
Option 4 ID : 4410095680983

Status : Not Answered
Chosen Option : --

Q.10
0

Which of the following steps is necessary to start creating a new document in Microsoft
Word?

Ans A. Choose “Open” from the “File” menu

B. Click “Insert” tab

C. Press “Alt + F4”

D. Use “New” option from the “File” menu

Question Type : MCQ
Question ID : 4410091416193
Option 1 ID : 4410095593475
Option 2 ID : 4410095593473
Option 3 ID : 4410095593476
Option 4 ID : 4410095593474

Status : Answered
Chosen Option : D
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